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This chapter contains the following sections:

• Quick-Start Installation

• Default Directories

• Installing Cisco Hub/Ring Manager

• Reinstalling Cisco Hub/Ring Manager

• Learning to Use Cisco Hub/Ring Manager

Quick-Start Installation
If you are familiar with installing network software, you can perform the following steps to
install the components needed to run Cisco Hub/Ring Manager:

Step 1 Install and load a WINSOCK-compliant TCP stack according to the
documentation that came with your TCP/IP package.

Step 2 Install HP OpenView or HP Workgroup Node Manager.

Step 3 Install the HP OpenView patch (included with Cisco Hub/Ring Manager).

Step 4 Install Cisco Hub/Ring Manager for Windows.

If you are not familiar with installing network software, proceed with the step-by-step
installation information.
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Default Directories
Unless you specify alternative directories during installation, Cisco Hub/Ring Manager
uses the following default directories:

• HP OpenView—C:\OV

• Cisco Hub/Ring Manager—C:\OV

Cisco Hub/Ring Manager must be installed in the HP OpenView directory. As long as
you meet this requirement, you can use any directory.

Before proceeding, confirm that you have installed the following software components in
this order:

1 HP OpenView 7.2 (version C.02.06 or later)

2 HP patch

Installing Cisco Hub/Ring Manager
To intall Cisco Hub/Ring Manager for Windows, perform the following steps:

Step 1 Insert the diskette labeled “Cisco Hub/Ring Manager (Number 1)” into drive A.

Step 2 From the Program Manager File menu, selectRun.

Step 3 In the command line entry field, enter the following:

a:\setup.exe

Click OK , or press theEnter key.

A status window indicates that the setup program is initializing.

The Cisco Hub/Ring Manager Installation dialog box appears, as shown in
Figure 2-1.

Step 4 Select the programs you want to install, then clickContinue. (See Figure 2-1.)

The Setup window contains checkboxes for Router/Hub Manager and Ring
Manager. Confirm that Router/Hub Manager is checked (this is the default). If you
want Ring Manager installed, click the Ring Manager checkbox.
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Figure 2-1 Cisco Hub/Ring Manager Installation Dialog Box

You may not need Ring Manager if you are using another management package,
such as IBM NetView or IBM LAN Network Manager (LNM), or if you are not
managing any Token Ring networks. Ring Manager has its own polling
mechanism, so not installing it can speed up other HP OpenView applications and
conserve memory in your network management PC.

Be sure Cisco Hub/Ring Manager is installed in the same directory and
subdirectories as HP OpenView.

Step 5 When prompted by the Setup message, remove diskette number 1 and insert
diskette number 2 into drive A.

Step 6 Follow the instructions displayed on your screen to continue the installation.

A dialog box appears that allows you to update configuration (*.INI) files, as
shown in Figure 2-2.
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Figure 2-2 Update Configuration Files Dialog Box

The default adds new entries and preserves any existing entries. This default
setting satisfies most needs for updating configuration files.

Step 7 If you do not have special configuration needs, clickContinue and skip to Step 9.

If you want to reset defaults or customize entries, clickAdvanced. A dialog box
appears with options for updating configuration files. (See Figure 2-3.)

• Click “Automatically update files and reset to defaults” to replace existing .INI
files with new entries and to retain them as the default settings.

• Click “Add new entries and customize existing entries” to place the new
configuration files in the HP OpenView directory and customize the older ones
for use with Cisco Hub/Ring Manager for Windows.

Step 8 When you finish updating the configuration files, clickContinue.

Step 9 When the installation process is complete, the Setup Successful dialog box
appears, as shown in Figure 2-4.
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Figure 2-3 Options for Updating Configuration Files Dialog Box

Figure 2-4 Setup Successful Dialog Box
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Step 10 To verify proper installation, follow the steps shown in the Setup Successful
dialog box. To view your AUTOEXEC.BAT and CONFIG.SYS files, use the DOS
type or edit command or the Windows Notepad.

Step 11 Exit Windows and reboot your PC.

This completes the installation of Cisco Hub/Ring Manager for Windows. After you reboot
your PC and restart Windows and HP OpenView, the HP OpenView Control menu lists
menu items for Ring Manager, Hub/Ring Trap Manager, Hub Manager, Asset
Management, Attachment, Identify, Sync. Attachment, Ethernet Manager, and SNMP
Manager.

Note Some Cisco Hub/Ring Manager menu items may be unavailable (dimmed) until you
select a router/hub from your network map.

Reinstalling Cisco Hub/Ring Manager
You can skip this section unless you replace or reformat your hard disk or need to reinstall
Cisco Hub/Ring Manager for some other reason.

If you have full backups, follow the instructions for your backup program to restore all files.

If you have backups of the customized SYSTEM.INI and OVWIN.INI files, use them to
overwrite the default files installed by Microsoft Windows and HP OpenView. Otherwise,
follow the procedure in the previous section, “Installing Cisco Hub/Ring Manager,” to
restore the network management station to operating condition.

Learning to Use Cisco Hub/Ring Manager
This section is for network administrators using Cisco Hub/Ring Manager for the first time.
It provides a practice scenario that helps you understand how to set up your network
management station.
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Before Beginning This Exercise
To benefit the most from this tutorial, make sure that:

• Cisco Hub/Ring Manager is properly installed.

• You have at least one Cisco 2517, Cisco 2518, or Cisco 2519 router/hub running in the
network managed by the Cisco Hub/Ring Manager network management PC.

• You have read theHP OpenView Windows User’s Guide and are familiar with
HP OpenView.

To apply this exercise to your own network, fill in Table 2-1. Use addresses that are
appropriate for your Internet Protocol (IP) environment. The exercise assumes that you
have one router/hub and one network management PC.

Media Access Control (MAC) addresses are optional. The MAC address consists of 12
hexadecimal characters, for example, 7A4A82542722.

Table 2-1 Your Router/Hub and Network Management PC Information

After you record the information that identifies the router/hub and the network management
PC, you can begin the tutorial, as described in the next section.

Object Name Interfaces

Type IP Address Net Mask Default
Gateway

MAC Address

Router/hub PCbus0

tok0 or eth0

PC – – –
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Starting Cisco Hub/Ring Manager
To start Cisco Hub/Ring Manager, perform the following steps:

Step 1 Start Windows by entering the following command at the DOS prompt:

win

Step 2 Start HP OpenView by double-clicking on the HP OpenView icon.

If any messages appear, clickOK  until the default map (UNTITLED) is
displayed.

Drawing a Map
A map is a graphical representation of your network, made up of interconnected hubs, PCs,
printers, routers, and other objects. (For additional information, see theHP OpenView
Windows User’s Guide.)

Inserting a Router/Hub Object
To insert a router/hub object, perform the following steps:

Step 1 From the Edit menu, selectAdd.

The Add Object palette appears, as shown in Figure 2-5.

Step 2 Click on the symbol set arrow (the second of three down arrows on the right edge
of the palette) to display the list of available symbol sets. Select Compound
Object.

Step 3 Select Router/Hub from the list below Compound Object or by clicking on a
router/hub icon. Then click on the map where you would like this object to be
located. The object is placed in the map, and the Router/Hub Describe dialog box
appears.

You must define at least one interface for the NMS entity and at least one interface
for the RTR entity.
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Figure 2-5 Add Object Palette

Step 4 In the Router/Hub Describe dialog box Name field, enter a descriptive name for
your router/hub. (See Figure 2-6.) This name may contain up to 15 alphanumeric
characters, including spaces, and is always displayed in uppercase. The Label field
is taken automatically from the Name field and cannot be edited.

Step 5 The dialog box lists the network management processor system (NMS) and router
(RTR) components of the router/hub (referred to as entities). The NMS entity
communicates with the router/hub’s hub SNMP agent, and the RTR entity
communicates with the router/hub’s router SNMP agent.
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Figure 2-6 Router/Hub Describe Dialog Box

Step 6 With the NMS entity selected, clickInterfaces (or double-click on the name of
the entity). The Router/Hub Interfaces dialog box appears.

Note You must configure the router/hub interfaces properly to ensure proper polling of
attached devices and color coding of device status.

Step 7 If you will not be using Serial Line Internet Protocol (SLIP) to communicate with
the RS232 port of the NMS module, skip to Step 11. Otherwise, continue with
Step 8 to configure SLIP.

Note In order to make it the primary NMS interface for Cisco Hub/Ring Manager, make
sure you define the SLIP interface before you define the PC interface for the NMS entity.

Step 8 In the Type field, click the down arrow and select SL (for SLIP).
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Step 9 In the TCP/IP Parameters box, enter the IP Address, Net Mask, and Default
Gateway that you configured with SPSET for the SLIP interface of the hub agent.
(See the section “Running SPSET” in the chapter “Overview of Cisco Hub/Ring
Manager for Windows.”)

Step 10 Click Add.

The Interface type (SL_0) is displayed in the Current Interfaces window.

Step 11 In the Type field, click the down arrow and select PC (for PCbus). This interface
enables Cisco Hub/Ring Manager to communicate with PC-like firmware running
the hub’s SNMP agent.

You can optionally specify an identifier of your choice in the Segment field, the
telephone number of the system administrator in the Telephone field, and the
MAC address of the router/hub in the MAC Address field. If you leave Segment
and MAC Address blank, Ring Manager fills them in automatically.

Step 12 In the TCP/IP Parameters box, enter the IP address of the PCbus SNMP agent (hub
SNMP agent). This address is 1 greater than the IP address of the router/hub
PCbus0 interface. Enter the same net mask that you configured for PCbus0. For
Default Gateway, enter the PCbus0 IP address (without adding 1).

Step 13 Click Add.

The Current Interfaces list box displays the Interface type PC_0.

Step 14 Click OK  to exit the Interfaces dialog box and return to the Router/Hub Describe
dialog box.

You have now defined one or more interfaces for the NMS entity. In the next series
of steps, you will define another interface (TR_0 or ET_0) for the RTR entity.

Step 15 From the Router/Hub Describe dialog box, select the RTR entity.

Step 16 Click Interfaces to display the Router/Hub Interfaces dialog box. (See
Figure 2-7.)
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Figure 2-7 Router/Hub Interfaces Dialog Box

Step 17 In the Type field, click the down arrow and select TR (for Token Ring) or ET (for
Ethernet), depending on your router/hub.

You can optionally specify an identifier of your choice in the Segment field, the
telephone number of the system administrator in the Telephone field, and the
MAC address of the router/hub in the MAC Address field.

Step 18 In the TCP/IP Parameters box, enter the same IP address that you assigned to the
router/hub tok0 or eth0 interface. Enter the same net mask that you configured for
the Token Ring or Ethernet interface.

Default Gateway is optional and can usually be left blank.

Step 19 Click Add.

The Interface type (TR_0 or ET_0) is displayed in the Current Interfaces window.

Note You can assign a maximum of three interfaces for each entity. At a minimum, you
must define a PC interface for NMS and a TR or ET interface for RTR.
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Step 20 Click OK  to exit the Interfaces dialog box and return to the Router/Hub Describe
dialog box.

Step 21 Click OK  to exit the Router/Hub Describe dialog box and return to the map.

The router/hub symbol with the name you specified is now part of your network map. If the
router/hub is physically connected to the network management PC and communicating
with it, the router/hub symbol should soon change from blue to green. (If the router/hub is
not operating normally, the symbol changes to another color . See the section
“Color-Coding of Map Objects,” later in this chapter.)

When you exit the Router/Hub Describe dialog box, Cisco Hub/Ring Manage
automatically creates a new submap containing both a router object and a hub object.
Double-clicking on the router/hub object displays these router and hub objects individually.
(See Figure 2-8.)

Figure 2-8 Separate Router and Hub Objects

The router object represents the router integrated into the router/hub. It is identified by the
IP address of the RTR entity, or by a name if you define one in a domain name server in
your PC/TCP stack or with theConfigure Preferred Name command underLayout in the
HP OpenView Autodisovery menu. You must use this router object, not the original
router/hub object, to access Cisco Configuration Builder and CiscoWorks.

The hub object represents the hub portion of the Router/Hub. It is identified by the IP
address of the NMS entity, or by a name if you define one in a domain name server in your
PC/TCP stack or with theConfigure Preferred Name command. You cannot edit Describe
information for the hub object. Use the original router/hub object instead.

Note To avoid conflicts between Cisco Hub/Ring Manager and HP OpenView, you must
onfigure HP OpenView not to poll the PCbus interface of the router/hub.
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Inserting a PC Object
To add your network management PC to the network map, perform the following steps:

Step 1 From the Edit menu, selectAdd.

The Add Object palette appears. (See Figure 2-5.)

Step 2 Click on the symbol set arrow (the second of three down arrows on the right edge
of the palette) to display the list of available symbol sets. Select Computer.

Select a computer object from the list below Computer or by clicking on a
computer icon. Then click on the map where you want this object to be located.
The object is placed in the map, and its Describe dialog box appears. (See
Figure 2-9.)

Figure 2-9 Describe Personal Computer Dialog Box
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Step 3 In the Name field, enter a descriptive name for your network management PC.
This name may contain up to 64 alphanumeric characters, upper and lowercase,
including spaces. The Label field is taken automatically from the first 20
characters of the Name field and cannot be edited.

Step 4 Click Net Address to display the Edit Network Addresses dialog box.

Step 5 Enter the IP address of the PC as specified in Table 2-1.

Step 6 Click OK  to return to the Describe dialog box.

The IP address that you entered appears in the Network Address field.

Step 7 Click OK .

The name of the PC appears below its symbol. The PC symbol remains blue.

Graphically Connecting the PC to the Router/Hub
To connect the PC to the router/hub, perform the following steps:

Step 1 From the Add Object palette (see Figure 2-5), click theConnecting Line button
(the line segment with two vertical endpoints), then select a line type.

Step 2 Click on the center of the router/hub object and drag the line to the center of the
PC object.

A line now connects the two objects. Even if you move one of the map objects, the
line still connects them.

Note Drawing a line to connect the PC to the hub is only a graphical representation. It does
not establish network management connectivity between the two devices. To establish this
connectivity by adding a corresponding entry to the HP OpenView database, use the Hub
Attachment feature, described in the following steps.

Step 3 To attach the PC to the hub, select the router/hub symbol in your network map and
click the right mouse button.

A popup menu (also called a floating menu) appears.
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Step 4 SelectAttachment.

The Hub Attachment dialog box for the router/hub appears. (See Figure 2-10.)

Figure 2-10 Hub Attachment Dialog Box

Step 5 Click on a slot number to display the module installed in that slot. (The NMS
module in slot 0 and the Ethernet or Token Ring module in slot 1 are displayed
automatically.)

Step 6 Click on the port that is connected to the device you want to attach. The port’s
color changes to green.

Step 7 Return to the network map and select the PC object by clicking on it. If necessary,
drag the Hub Attachment dialog box or the module display to expose the PC
object.

Another way to select the PC object is to click on theOpen command button (the
opening folder) in the Hub Attachment dialog box. Select the PC from the list.

Step 8 Click on theAttach command button (the plus sign) in the Hub Attachment dialog
box. The port symbol changes to blue.

Note Click on theAttach icon in the Hub Attachment dialog box, not the Device
Attachment dialog box.
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Step 9 Click on slot0 to display the NMS module.

Step 10 Click on the ADJ LAN port. The port’s color changes to green. This attachment
enables you to connect the router component to the hub component.

Since the router component does not appear in the Hub Attachment dialog box, its
TR or ETH port is represented as an ADJ LAN port on the NMS module in slot 0.
This port connects to port 1 of the Token Ring hub module (or to port 2 if port 1
is set to EXT mode on a Cisco 2517), or to any port of the Ethernet hub module.

Step 11 Click on the hub port to which the router component is connected. The port’s color
changes to green.

Step 12 Click on theAttach command button. Both port symbols change to blue.

Step 13 Double-click the upper left corner of the Hub Attachment dialog box to exit.

Step 14 From the Control menu, selectSync. Attachment. The PC icon on the map soon
changes color to indicate its status; this change can take up to several minutes,
depending on your polling settings.

Note Configure HP OpenView not to poll attached PCs and other non-IP devices.

Inserting a Submap Symbol
For large networks, you may want to divide the map into submaps. A home map contains
a submap symbol so that you can glance at the overall network status from the home map.
For an explanation of propagation in submaps, refer to theHP OpenView Windows User’s
Guide.To insert a submap symbol, perform the following steps:

Step 1 From the Edit menu, selectAdd.

The Add Object palette appears.

Step 2 Click on the symbol set arrow (the second of three down arrows on the right edge
of the palette) to display the list of available symbol sets. Select Compound
Object.
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Step 3 Select a submap symbol from the list below Compound Object or by clicking on
a submap icon. Then click on the map where you would like this submap to be
located.

The object is placed in the map, and the Describe Submap dialog box appears.

Step 4 Fill in the entries in the dialog box and clickOK .

Saving Your Network Map
To save your network map, perform the following steps:

Step 1 From the File menu, select theSave As command.

Step 2 EnterPRACTICE  as the name of the map and clickOK .

The extension .OVM is automatically added to the map name. The title bar
displays PRACTICE: UNTITLED.

Step 3 From the Edit menu, select theRename Submap command.

Step 4 Name the current submapTUTORIAL .

The title bar displays PRACTICE: TUTORIAL.

Changing the Default Map
The default map is displayed when you start Cisco Hub/Ring Manager. To change the
default map, perform the following steps:

Step 1 From the Options menu, selectCustomize HP OpenView.

The Customize HP OpenView dialog box appears.

Step 2 Click Browse to find the preferred map.

Step 3 Click OK .
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Changing the Default Submap
The default submap is displayed when you start Cisco Hub/Ring Manager. To change the
default submap, perform the following steps:

Step 1 From the Edit menu, selectSet Home Submap.

The Set Home Submap dialog box appears.

Step 2 Select the preferred submap.

Step 3 Click OK .

Control Panel
The router/hub Control Panel provides a color-coded graphical representation of the
router/hub, its current status, and the status of each module in it. The screen is periodically
updated to reflect any changes in a port LED or module. To access the Control Panel,
perform the following steps:

Step 1 From your HP OpenView network map, select the router/hub object.

Step 2 Click the right mouse button to display the popup menu.

Step 3 SelectControl Panel.

Figure 2-11 shows the Control Panel for a Cisco 2518 router/hub.

From the Control Panel, you can display a popup menu by clicking on any of the areas
shown in dotted boxes. The popup menu commands vary depending on the router/hub, the
modules installed in it, and the area where you click.

For example, to disconnect a port, perform the following steps:

Step 1 Select a port by clicking with the left mouse button on the dotted box around the
port number.

A popup menu listing the available commands appears.
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Figure 2-11 Router/Hub Control Panel

Step 2 Click Disconnect.

A dialog box prompts you to confirm your action. If you clickYes, the following
responses occur:

• You receive a message confirming that the command has been sent.

• The port is disconnected from the network

• The LED changes to a magenta color.

• The Alarm Log records the event.

Caution To avoid accidental network interruption, be careful to disconnect only the port
you want.

Step 3 Select the port again and clickReconnect to reconnect the port.

From the Control Panel, you can also reset the NMS or router portions of the router/hub:

• To reset the NMS, click the box below RESET and selectResetfrom the popup menu.

• To reset the router, click the area around the word Router and selectReset.

If Configuration Builder is installed on your HP OpenView PC, you can start it by clicking
the area around the word Router and selectingConfiguration.



 Installing Cisco Hub/Ring Manager for Windows 2-21

Learning to Use Cisco Hub/Ring Manager

On a Cisco 2518, the Control Panel popup menu includes a choice forEth Statistics. The
Ethernet Statistics window, shown in Figure 2-12, displays real-time, port-level statistical
information.

Figure 2-12 Ethernet Statistics Window

A graphical display of the module indicates LED status for all ports. The Ethernet module
is shown as ECM (Ethernet connectivity module). An arrow indicates the port currently
being monitored. To monitor a different port on the same module, double-click on the
dotted box next to the port number in the Ethernet Statistics window. The arrow moves to
the selected port.
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Gauges near the top of the window display the current value, in events per second, of three
types of events:

• Receive, shown in shades of green

• Collisions, shown in yellow through red

• Frequency alignment errors (FAE), shown in shades of blue

FAE events include Jabber Protect Event, Elasticity Buffer Error, Phase Lock Error,
Pygmy Packets (Short Event Reception), Non-SFD Packet Event, Partition Event, and
Bad Link Event.

Each gauge is divided into a low, normal, and high range according to a low threshold and
a high threshold, which you can set in Ethernet Manager. (See the section “Ethernet
Manager,” later in this chapter.) The upper end of the gauge is 150 percent of the high
threshold value. Each time the number of events per second crosses a threshold in either
direction, an alert is sent to the network management station.

The boxes below the gauges are counters that indicate the total number of events that have
occurred since the window was opened.

A graph below the boxes displays the rate at which events have occurred over a period of
time. To select the type of event shown, click one of the option buttons above the graph.
The scale for the vertical axis is set bySet Statistics Graph Scale in Ethernet Manager.
(See the section “Ethernet Manager,” later in this chapter.) The horizontal axis shows the
time (in minutes) since the Ethernet Statistics window was opened.

As long as the Ethernet statistics window is open, all events for the selected port are
recorded in a log file. Three files are created, one for each event type, for each port whose
statistics have been monitored. To display a file, select a port and an event type.

The Ethernet Statistics window remains open even after the Control Panel has been closed,
and continues adding events to the log file. You can minimize the window for more screen
space.

You can have up to four Ethernet statistics windows open simultaneously. To
simultaneously monitor another port on the same module, click onNew Window and
double-click on the desired port in the new window. To monitor another port either on the
same module or in another hub, select the port in the Control Panel and click onEth
Statistics in the popup menu.
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Monitoring and Managing the Network
After you create your network map and attach all objects and hubs to their ports, you can
begin monitoring the network. You, or another person managing the network, can review
the Alarm Log (bell icon) and the hub’s Control Panel to search for any changes in network
status. As the network manager, you may also want to perform certain operations on the
objects.

This section summarizes some frequently used monitoring options. Detailed explanations
of each of the following topics are included in the chapter “Using Cisco Hub/Ring Manager
for Windows.”

Popup Menus
When you select certain objects in the map and click the right mouse button, a popup menu
appears. The menu provides quick access to frequently used operations. (See Table 2-2.)

Table 2-2 Popup Menus

Item Commands

Router/hub Describe…
Alarms…
Control Panel…
Attachment…

Router Describe…
Alarms…
Attachment…

Hub Describe… (read-only)
Alarms…
Control Panel…
Attachment…
Manage Object
Unmanage Object

PC Describe…
Alarms…
Identify…
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Receiving SNMP Traps
You must configure your Cisco Hub/Ring Manager station in order for it to receive traps
from SNMP agents in the router/hub. All traps are displayed, along with alarms, in the
HP OpenView Alarm dialog box.

To configure your Cisco Hub/Ring Manager station, perform the following steps:

Step 1 From the Options menu, selectHub/Ring Application Setup.

The Hub/Ring Application Setup dialog box appears.

Step 2 In the Application section, clickTrap Manager.

The Trap Config Directory field appears. The directory C:\OV\TRAPCONF\ is
specified as the default directory for traps received by Cisco Hub/Ring Manager
stations.

Step 3 To change the default, enter the destination directory where the Cisco Hub/Ring
Manager station should receive traps.

Step 4 Select Hub Manager in the list box. Enter your preferences for polling time and
timeouts.

Step 5 Select Ring Manager in the list box (if installed). Enter your preferences for
polling time and timeouts.

Step 6 Click OK  to confirm your preferences for Hub/Ring Application Setup.

Ring Describe…
Alarms…
Ring Configuration…
Ring Monitor…
Manage Submap
Unmanage Submap

Submap Describe…
Alarms…
Manage Submap
Unmanage Submap

Item Commands
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Note You must also configure your router/hub to send traps to the network management
PC. See theCisco 2517 and Cisco 2519 Router/Hub User Guide and theCisco 2518
Router/Hub User Guide.

Customizing SNMP Traps
The Cisco Hub/Ring Manager SNMP agent issues three kinds of traps:

• Asynchronous external traps, sent by the agent to designated destinations when an
important event happens (ID greater than 51).

• Polled (buffered) external traps, kept in agent memory and polled by Trap Manager (ID
greater than 51).

• Internal traps, issued by Cisco Hub/Ring Manager components, such as Ring Manager
and Hub Manager, when they discover an important event that the agent is unable to
report (ID 1–50).

Each trap is defined in a separate file in the \OV\TRAPCONF directory. These files are
named TRPgssss.CNF, whereg is the generic trap (0–6) andssss is the specific trap ID. The
default file TRP99999.CNF captures incoming traps that are not specifically configured.

You can edit the text for each trap to customize the messages sent to the network
management station and the log file. For further information, refer to Cisco Hub/Ring
Mananger Alarm Help.

Note You cannot customize router/hub agent SNMP traps using theCustomize Traps
function of HP OpenView.
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Ring Manager
The All Rings window, shown in Figure 2-13, opens automatically when you start Cisco
Hub/Ring Manager. You can close it if you do not have any Token Ring networks.

If the All Rings window is minimized, double-click on the icon to maximize it. If it is
closed, open it by selectingAll Rings underRing Manager in the Control menu. To access
a Ring Manager function, select a ring under Ring Name and click on one of the
management function icons above it:Ring Monitor , Ring Configuration, Event Filter,
or Ring Events.

Figure 2-13 All Rings Window
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Ethernet Manager
Ethernet Manager, found in the Control menu, maintains event and alert logs of network
activity and errors at the port level. You can view graphical displays of this activity in the
Ethernet Statistics window, described in the section “Control Panel,” earlier in this chapter.

The Set Threshold Parameters dialog box, shown in Figure 2-14, defines alert thresholds at
the network level for three types of events: receive events, collisions, and frequency
alignment errors (FAE). You can set low and high thresholds in frames per second.

Figure 2-14 Set Threshold Parameters Dialog Box

The Set Statistics Graph Scale dialog box, shown in Figure 2-14, sets the vertical scale for
the Ethernet Statistics window in frames/sec. The default is Dynamic Scale, which sets the
scale automatically depending on the magnitude of the data. If you choose Fixed Scale, you
can set the maximum value in the scale yourself using the horizontal scroll bar.

Graphical information displayed in the Ethernet Statistics window is saved in files for
future retrieval. These files are in binary format and can be retrieved only by selecting a port
and an event type in the Ethernet Statistics window.

The Ethernet Statistics File Management dialog box, shown in Figure 2-16, is designed for
advanced management of statistical files. You do not normally need to change any of the
default settings in this dialog box. Ethernet Manager automatically manages the files and
deletes the oldest ones as required.
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Figure 2-15 Set Statistics Graph Scale Dialog Box

Figure 2-16 Ethernet Statistics File Management Dialog Box
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Hub Configuration
The Hub Configuration window shows a hub’s hardware revision, software revision,
jumper settings for modules, and jumper settings that have been overridden by software
commands.

Note The Hub Configuration window displays information about the router/hub’s
network management component and Token Ring or Ethernet modules, but not the router
component.

To access the Hub Configuration window, perform the following steps:

Step 1 From your HP OpenView network map, click on the router/hub object.

Step 2 From the Control menu, selectAsset Management.

Step 3 SelectHub Configuration.

The Hub Configuration window appears. (See Figure 2-17.) Click on a slot
number to display jumper settings for the module in that slot.

Figure 2-17 Hub Configuration Window
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Color-Coding of Map Objects
Objects in the network map are color-coded to indicate their network status. An object is
green during normal operation, magenta if it has been disconnected by the user, yellow if it
is operating but in a warning state, red if a major problem has been detected with it, blue if
Cisco Hub/Ring Manager is unable to locate information on it, and wheat-colored (pale
yellow) if it is unmanaged.

Ring Events and Alarm Log
Alarms indicate status changes in any device on the network. Cisco Hub/Ring Manager
tracks all network alarms (also called events). In addition, HP OpenView tracks certain
critical and platform-specific alarms.

The Ring Events window displays all Token Ring events and identifies MAC frames that
have been sent at the MAC layer. The HP OpenView Alarm Log, in contrast, displays only
serious traps and alarms for devices in the network. For additional information, refer to the
HP OpenView Windows User’s Guide.

To view all ring events and alarms, perform the following steps:

Step 1 Maximize the All Rings window if it is open. If it is closed, selectAll Rings under
Ring Manager in the Control menu to open it.

Step 2 Click theAlarms command button (a bell) in the toolbar to display the Ring
Events window. This window displays ring events and network alarms. The Ring
Manager Events Filter allows you to select the kinds of events that are reported in
the Ring Events window.

Another way to open the Ring Events window is to selectRing Monitor  under
Ring Manager in the Control menu, and then click on theEvents command
button in the Ring Monitor window.

To display alarms for a single object in the network, perform the following steps:

Step 1 Select the object in your network map.

Step 2 Click the right mouse button.

Step 3 SelectAlarms.

The HP OpenView Alarm Log appears. This log displays alarms for the object.
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Selective Management
Selective management is the process of identifying and isolating network problems by
enabling or disabling management of certain hubs or Hub/Ring Manager applications.

Selective Hub Management
You can choose to manage or not manage any hub in the map or all hubs within a particular
submap. Token Rings in an unmanaged submap appear as either unmanaged (pale yellow)
or unknown (blue).

Note Even if a hub is unmanaged, the hub agent continues to report traps to the network
management station if configured to do so. Managing affects only polling by Cisco
Hub/Ring Manager applications.

You can perform selective hub management from the Hub/Ring Object Manager dialog box
(from the Options menu, selectHub/Ring Object Manager). In this dialog box, a diamond
represents an object and an octagon represents a submap. Yellow means Unmanage and
green means Manage.

Note In the Hub/Ring Object Manager dialog box, an asterisk appears next to the names
of devices that are currently being managed.

You can also select an object, click on the right mouse button, and selectManage Object
or Unmanage Object. The hub object turns pale yellow to indicate that it is unmanaged.
Selective management becomes the new default for subsequent Cisco Hub/Ring Manager
sessions.

To disable management of all hubs in a submap, select the submap symbol, click on the
right mouse button and selectUnmanage Submap. The submap symbol turns pale yellow
to indicate that it is unmanaged. Selective management of submaps is not propagated to
other submaps.
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Selective Application Polling
Each Cisco Hub/Ring Manager session starts with all applications (Ring Manager, Hub
Manager, and Trap Manager) active—that is, polling hubs in the map. Active applications
have a checkmark next toEnable Polling under the application’s name in the Control
menu. (Ethernet Manager does not appear in this list, because it polls only when the
Ethernet Statistics window is open.)

To deactivate an application, select the application from the Control menu and then select
Disable Polling.

Updating a Token Ring Map
On a Token Ring network, you must update the MAC database after using the layout
function, assigning MAC addresses in the Describe dialog box, or changing MAC
addresses in the Name Settings dialog box. To update this database, perform the following
steps:

Step 1 From the Control menu, select theRing Manager submenu.

Step 2 SelectSync. MAC Database.

This function is also performed automatically when Ring Manager initializes.


